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1. Introduction 
 
1.1. Microchannel 
Fluid flow inside channels is at the heart of many natural and man-made systems. Heat and mass transfer are accomplished across the 
channel walls in biological systems, such as the brain, lungs, kidneys, intestines, blood vessels, etc., as well as in many man-made 
systems, such as heat exchangers, nuclear reactors, desalination units, air separation units, etc. In general, the transport processes 
occur across the channel walls, whereas the bulk flow takes place through the cross-sectional area of the channel. The channel cross-
section, thus serves as a conduit to transport fluid to and away from the channel walls. A channel serves to accomplish two objectives: 
(i) bring a fluid into intimate contact with the channel walls and (ii) bring fresh fluid to the walls and remove fluid away from the 
walls as the transport process is accomplished. The rate of the transport process depends on the surface area, which varies with the 
diameter D for a circular tube, whereas the flow rate depends on the cross-sectional area, which varies linearly with D2. Thus, the tube 
surface area to volume ratio varies as 1/D. Clearly, as the diameter decreases, surface area to volume ratio increases. In the human 
body, two of the most efficient heat and mass transfer processes occur inside the lung and the kidney, with the flow channels 
approaching capillary dimensions of around 4μm.Figure 1 shows the ranges of channel dimensions employed in various systems. 

    ISSN 2278 – 0211 (Online) 

Karthikeyan V. 
PG Scholar, Department of Mechanical Engineering,  

Vidyaa Vikas College of Engineering &Technology, Erode, Tamil Nadu, India 
Sundaram K. 

Assistant Professor, Department of Mechanical Engineering,  
Vidyaa Vikas College of Engineering & Technology, Erode, Tamil Nadu, India 

Balamurali S. 
Associate Professor, Head of the Department, Mechanical Engineering,  

Vidyaa Vikas College of Engineering & Technology, Erode, Tamil Nadu, India 
 

Abstract: 
Due to the high performance of electronics components, the heat generation is increasing dramatically. Heat dissipation becomes a significant 
issue for stable operation of components. Micro channels provide very high heat transfer coefficients because of their small diameters. In this 
study, two dimensional fluid flow and heat transfer in a rectangular micro channel heat sink are analyzed using FLUENT as a solver with 
water as cooling fluid. With strong literature study, it is found that down to 50 μm of hydraulic diameter, macro scale model can be applicable. 
Three channels of height 50 μm, 100 μm and 150 μm are considered. The study is mainly focused on Nusselt Number and height effects on 
micro channel thermal performance. The highest temperature is encountered at the heated surface of the heat sink immediately above the 
channel outlet. The thermal resistance becomes smaller at the small channel height, indicating that the heat transfer performance can be 
enhanced at small channel height. Pressure drop becomes more for large channel height and length.  
 

 
 
Keywords: Heat transfer, diameter, cross-sectional area 
 



   www.ijird.com                                       March, 2015                                                Vol 4   Issue 3 
  

INTERNATIONAL JOURNAL OF INNOVATIVE RESEARCH & DEVELOPMENT Page 165 
 

Interestingly, the biological systems with mass transport processes employ much smaller dimensions, whereas larger channels are used 
for fluid transportation. From an engineering standpoint, there has been a steady shift from larger diameters, on the order of 10–20 
mm, to smaller diameter channels. Since the dimensions of interest are in the range of a few tens or hundreds of micrometers, usage of 
the term “microscale” has become an accepted classifier for science and engineering associated with processes at this scale. 
 
2. Fundamental Issues in Liquid Flow at Microscale 
Microchannels are used in a variety of devices incorporating single-phase liquid flow. The early applications involved micro machined 
devices such as micropumps, microvalves and micro sensors. This was followed by a thrust in the biological and life sciences with a 
need for analyzing biological materials, such as proteins, DNA, cells, embryos, and chemical reagents. The field of micro mixers, 
further received attention with developments in micro reactors, where two chemical species are mixed prior to introducing them into a 
reaction chamber. The high flux, heat dissipation from high-speed microprocessors provided the impetus for studies on heat transfer in 
microchannels. The developments in the microelectromechanical devices naturally require heat removal systems that are equally 
small. Cooling of mirrors employed in high-power laser systems involves cooling systems that cover very small footprints. Advances 
in biomedical and genetic engineering require controlled fluid transport and its precise thermal control in passages of several 
micrometer dimensions. A proper understanding of fluid flow and heat transfer in these microscale systems is therefore essential for 
their design and operation. Gad-el-Hak argued that liquids such as water should be treated as continuous media with the results 
obtained from classical theory being applicable in channels larger than 1 μm. However, there remain a number of unresolved issues 
that require further study. 
 
2.1. Need for Smaller Flow Passages 
The flow passage dimensions in convective heat transfer applications have been shifting towards smaller dimensions for the following 
three main reasons: 

1. Heat transfer enhancement. 
2. Increased heat flux dissipation in microelectronic devices. 
3. Emergence of microscale devices that require cooling. 

Employing smaller channel dimensions results in higher heat transfer performance, although it is accompanied by a higher pressure 
drop per unit length. The higher volumetric heat transfer densities require advanced manufacturing techniques and lead to more 
complex manifold designs. An optimum balance for each application leads to different channel dimensions. For example, in the 
refrigeration industry, the uses of microfin tubes of 6–8mm diameter have replaced the plain tubes of larger diameters. In automotive 
applications, the passage dimensions for radiators and evaporators have approached a 1mm threshold as a balance between the 
pumping power, heat transfer, and cleanliness constraints imposed by the overall system.  
Microelectronic devices, which include a variety of applications such as PCs, servers, laser diodes, and RF devices, are constantly 
pushing the heat flux density requirements for higher levels. What seemed to be an impossibly high limit of 200W/cm2 of heat 
dissipation in 1993 now seems to be a feasible target. The new challenge for the coming decade is on the order of 600–1000W/cm2. 
The available temperature differences are becoming smaller, in some cases as low as only a few ◦C with external copper heat sinks. 
These high levels of heat dissipation require a dramatic reduction in the channel dimensions, matched with suitable coolant loop 
systems to facilitate the fluid movement away from the heat source. A cooling system for a microscale device might require cooling 
channels of a few tens of micrometers as compared to more conventional sized channels with 1–3mm flow passage dimensions. In 
addition, several such units may be clustered together and a secondary cooling loop may be employed to remove the heat with a 
conventional cooling system. Figure 3.1 shows a schematic of a microchannel cooling system configuration for cooling a server 
application. The combination of the microchannel heat exchangers, mounted directly on the chip or in the heat sink that is bonded to 
the chip, water cooled cold plates with minichannel or microchannel flow passages, and auxiliary localized cooling systems will be 
able to address the complex cooling needs of the high send servers. The cooling system is integrated with the building HVAC system 
as described by Kandlikar. 
A schematic of direct liquid cooling of a multichip module or a heat sink is shown in Fig. 3.2. The liquid flows through the cold plates 
that are attached to a substrate cap. In advanced designs, direct cooling of chips is accomplished by circulating water, a water 
antifreeze mixture, oil, or a dielectric fluid, such as FC-72, FC-77 or FC-87 through microchannels that are fabricated on the chip 
surface. Copper heat sinks with integrated microchannels and minichannels are expected to dominate heat sink applications. 
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Figure 1: Schematic of Direct Liquid Cooling of a Multichip Module 

 
2.2. Heat Transfer in Microchannels 
  
2.2.1. Fully Developed Laminar Flow 
The Nusselt number in the fully developed laminar flow is expected to be constant as predicted by the classical theory. However, there 
are a number of investigations reported in the literature that show a trend increasing with Reynolds number in this range. The Nusselt 
number in the fully developed laminar flow is constant and depends on the channel geometry and the wall heat transfer boundary 
condition. For a rectangular channel, the Nusselt number depends on the channel aspect ratio ߙc=a/b, and the wall boundary 
conditions. Three boundary conditions are identified in literature and the Nusselt number for each one is given below. 
Constant wall temperature, T-boundary condition: 

               3.11 
Constant circumferential wall temperature, uniform axial heat flux, H1 boundary condition: 

  3.12 
Constant wall heat flux, both circumferentially and axially: 

 3.13 
In reality, all practical situations fall somewhere in the middle of these three boundary conditions. This becomes an especially 
important issue in the case of microchannels because of the difficulty in identifying a correct boundary condition with discretely 
spaced heat sources, and two-dimensional effects in the base and the fins. The nusselt number is a dimensionless number that 
measures the enhancement of heat transfer from a surface that occurs in a real situation compared to the heat transferred if just 
conduction occurred. 
 
3. Mathematical Formulation 
Here the micro-heat sink model consists of a 10 mm long substrate and dimension of rectangular microchannels have a width of 50 
μm and a depth of 50 μm as shown in Fig (2). The heat sink is made from silicon and water is used as the cooling fluid. The electronic 
component is idealized as a constant heat flux boundary condition at the heat sink bottom wall. Heat transport in the unit cell is a 
conjugate problem which combines heat conduction in the solid and convective heat transfer to the coolant (water). But here it is 2D 
problem we cannot consider heat conduction.  
 

 
Figure 2 
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S. No a (μm) b (μm) L (mm) Dh (μm) 

1. 50 50 10 50 
20 

2. 50 100 10 66.667 
20 

3. 50 150 10 75 
20 

Table 1: Channel Dimensions 
 

We consider three rectangular channels of different dimensions are specified in Table 4.1.  Here we assumed to have a constant heat 
flux, q” (50 W/cm2, 100 W/cm2 and 150 W/cm2) at the bottom wall .The other wall boundaries of the solid region are assumed 
perfectly insulated with zero heat flux. The water flow velocities are taken from different Reynolds numbers, from 100 to 500, with 
reference to the corresponding hydraulic diameter. 
 
3.1. Assumptions Made 

1. Laminar Flow 
2. Uniform Wall Heat Flux. 
3. Negligible Radiation Heat Transfer 
4. Constant Heat Flux  
5. Incompressible Fluid 

 
3.2. Governing Equations 
The conjugate heat transfer and the fluid flow inside the microchannel structure were numerically modeled. Whatever may be the 
situation the model has to satisfy the three fundamentals laws:  

1. Conservation of Mass (Continuity Equation)  
2. Conservation of Momentum (Newton’s Second Law) 
3. Conservation of Energy (First Law of Thermodynamics) 

Hence Steady state continuity, momentum (Navier-stokes Equation) and energy equations are solved using FLUENT. 
 Continuity Equation 

     3.1 
 Momentum Equations (Navier-Stokes Equations) 

X- Momentum  

 -  3.2 
Y-Momentum 

 -  3.3 
 Energy Equation 

                3.4  
 
3.3. Boundary Conditions 
If the whole unit cell is chosen as a unitary domain, the boundary conditions can be specified as follows. For the hydraulic boundary 
conditions, the velocity is zero at all boundaries except the channel inlet and outlet. A uniform velocity is applied at the channel inlet. 

    3.5 
The flow is fully developed at the channel outlet.   

  , for x=L    3.6 
For the thermal boundary conditions, adiabatic boundary conditions are applied to all the boundaries except the channel bottom wall, 
where a constant heat flux is assumed. 

  3.7 
At the channel inlet, the liquid temperature is equal to a given constant inlet temperature. 
    3.8 
The flow is assumed thermally fully developed at the channel outlet. 
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   3.9 
It should be noted here that the temperature field may not be fully developed if the entrance length is longer than the channel length. 
However, the change of temperature gradient along the flow direction at the channel exit is usually very small even for very large 
Reynolds numbers. 
 
4. Microchannel Modeling Using Gambit 

 STEP 1 Select a solver: 
 Main Menu>Solver>Fluent 5/6. 

 STEP 2 Creation of Vertices: 
 Operation>Geometry>Vertex  
 Command Button>Create Vertex from Co-ordinates. 

 

 
Figure 3 

 
The following vertices with the required Cartesian co-ordinates were created. All dimensions are in ‘mm’. 
 

Vertices Cartesian Coordinates 
A 0,0 
B 10,0 
C 10,0.05 
D 0,0.05 

Table 2 
 

 STEP 3  Creation of Line: 
 Operation>Geometry>Creating Edge>Straight. 
 Create straight lines by joining the following vertices 
 AB, BC, CD, DA, 

 STEP 4 Creation of Faces: 
 Operation>Geometry>Face Command Button>Form Face>Create Face from Wireframe. 
 To create face ‘ABCD’, select edges in a sequence order (AB>BC>CD>DA) and click apply. 

 STEP 5 Meshing Edges (AB, BC, CD, and DA: 
 Operation>Mesh>Mesh edges. 
 Select Edge-AB, CD 
 Grading-Apply 

 Type-Successive ratio. 
 Ratio-1.0 
 Spacing-Apply 
 Interval Size: 0.01 
 Mesh-Apply 
 Click Apply. 
 Select edge- BC, DA 
 Grading-Apply. 
 Type-Successive Ratio. 
 Ratio-1.0 
 Spacing-Apply 
 Interval Size: 0.01 
 Mesh-Apply 
 Click Apply. 
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 STEP 6 Mesh face. 
 Operation>Mesh  
 Command Button>Face mesh>Mesh faces. 

 Faces- Select face 1 
 Elements- Quad. 
 Type- Map 
 Interval Size- 0.01 
 Click Apply 

 STEP 7 Creating Zones. 
 Operation>Zones  
 Command Button> Specify Boundary Types. 

 STEP 8 Creation of Continuum. 
 Operation>Zones  
 Command Button> Specify Continuum Types. 

 STEP 9 File>Save as [name] 
 STEP 10File>export>Mesh [File name] 

 Repeat the procedure from step 1 to step 10 for the modeling the other five micro channel dimensions.  
 
5. Fluent Analysis of Microchannel 
 
5.1. Steps to Be Followed in Fluent 

 STEP 1 Select FLUENT 2ddp. 
 STEP 2 Reading of the mesh file. 

 Figure 4Meshed Microchannel 
 File>Read>Case. 

 STEP 3 ANALYSIS OF GRID. 
 Checking of grid 

 Grid>Check. 
It was checked that the total volume doesn’t come as negative. 

 Scaling of Grid. 
 Grid>Scale. 
Scale was set to 1e-6 in X, Y, Z directions. 

 Smoothing and Swapping. 
 Grid>Smooth/swap. 
 The grid was swapped until Zero faces were moved. 

 STEP 4 SELECTIONS OF MODELS. 
 Defining solver. 
 DEFINE>MODELS>SOLVER. 
 Define Energy Equation. 
 DEFINE > MODEL >ENERGY. 
 Active Energy Equation 
 Define Viscous Model. 
 DEFINE > MODEL >VISCOUS 
 Model: Laminar 

 STEP 5 DEFINE MATERIALS 
 DEFINE > MATERIALS. 
 Fluid was taken to be liquid water which has the following properties. 

 STEP 6 Defining Operating Conditions. 
 DEFINE >OPERATING CONDITIONS. 
 Operating pressure= 101.325 KPa 

 STEP 7 Defining Boundary Conditions. 
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5.1.1. Channel Inlet. 
Input the following values at Velocity Inlet.  
 

Momentum 
Velocity 

Specification 
Method 

Magnitude, 
Normal to 
Boundary 

Reference Frame Absolute 
Velocity Magnitude 1.76769 m/s 

Thermal 
Temperature 300 K 

Table 3 
 

5.1.2. Channel Outlet. 
Input the following values at Pressure Outlet. 
 

Momentum 
Gauge Pressure 0 Pascal 

Backflow Direction Specification Method Normal to Boundary 
Target Mass Flow Rate 4.4 X 10-6 Kg/s 

Table 4 
 

5.1.3. Bottom Wall. 
Input the following values at Wall. 
 

Momentum  
Wall Motion Stationary 

Shear Condition No Slip 
Thermal 

Heat Flux 50X104 W/m2 

Table 5 
5.1.4. Top Wall. 
Input the following values at Wall. 
 

Momentum  
Wall Motion Stationary 

Shear Condition No Slip 
Thermal 

Heat Flux 0 W/m2 

Table 6 
 

 STEP 8 CONTROL OF SOLUTION. 
 SOLVE > CONTROLS>SOLUTION 

 
Equations Flow 

Under Relaxation Factor 

Pressure 0.3 
Density 1 

Body Forces 1 
Momentum 0.7 

Energy 0.8 
Pressure Velocity 

Coupling SIMPLE 

Discretization 
Pressure Standard 

Momentum Second Order Upwind 
Energy Second Order Upwind 
Table 7 
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 STEP 9 INITIALIZING THE SOLUTION. 
 SOLVE > INITIALIZE>INITIALIZE. 
 

Compute From All Zones 
Reference Frame Relative to Cell Zone 

Initial Values 

Gauge 
Pressure 0 

X Velocity 0 
Y Velocity 0 

Temperature 300 K 
Table 8 

 
 STEP 10MONITOR THE RESIDUALS. 

 SOLVE > MONITORS>RESIDUALS. 
 

Options Plot 

Plotting 
Windows 1 
Iterations 1000 

Normalization Scale 

Convergence 
Criterion Absolute  

Continuity   

X Velocity  

Y Velocity  

Energy  

Table 9 
 STEP 11ITERATING THE SOLUTION. 

 SOLVE >ITERATE. 
 No. of iterations=500. 
 Iterate till the solution for flow equations is converged. 

 STEP 12SOLVE ENERGY EQUATION. 
 SOLVE >CONTROLS>SOLUTION 
 Activate the Energy Equation 

 STEP 13ITERATING THE SOLUTION. 
 SOLVE >ITERATE. 
 No. of iterations=500. 
 Iterate till the solution for flow and energy equations is converged. 

 STEP 14SAVE THE FILE WITH DATA 
 FILE>WRITE>CASE&DATA 
 Save with File Name 

 STEP 15 DISPLAY THE CONTOURS 
(a) Contours of Temperature 

  DISPLAY>CONTOURS 
  Options: Filled  
  Contours of Temperature (Static Temperature) were selected. 

Filled option was clicked. 
All Surfaces are selected 
Click Display to see the Contours of Temperature. 

(b) Contours of Velocity: 
DISPLAY>CONTOURS. 
Contours of Velocity (Velocity Magnitude) were selected. 
Filled option was clicked. 
All Surfaces are selected. 
Click Display to see the Contours of Velocity. 

(c) Contours of Pressure: 
DISPLAY>CONTOURS. 
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Contours of Pressure (Static Pressure) were selected. 
Filled option was clicked. 
All Surfaces are selected. 
Click Display to see the Contours of Pressure 

(d) Contours of Wall Fluxes: 
DISPLAY>CONTOURS. 
Contours of Wall Shear Stress were selected. 
Filled option was clicked. 
All Surfaces are selected. 
Click Display to see the Contours of Shear Stress 

(e) Contours of Wall Fluxes: 
DISPLAY>CONTOURS. 
Contours of Skin Friction Coefficient were selected. 
Filled option was clicked. 
All Surfaces are selected. 
Click Display to see the Contours of Skin Friction Coefficient. 

(f) Contours of Wall Fluxes: 
DISPLAY>CONTOURS. 
Contours of Surface Heat Transfer Coefficient were selected. 
Filled option was clicked. 
All Surfaces are selected. 
Click Display to see the Contours of Surface Heat Transfer Coefficient. 

(g) Contours of Wall Fluxes: 
DISPLAY>CONTOURS. 
Contours of Surface Nusselt Number were selected. 
Filled option was clicked. 
All Surfaces are selected. 
Click Display to see the Contours of Surface Nusselt Number. 

 STEP 16 PLOT THE XY GRAPH 
PLOT>XY 
Nodal Values and Position on X-axis was clicked. 
Select all the surfaces. 

(a) Y-axis function as Temperature was selected. 
Click Plot to plot the graph between Temperature & Length of Channel. 
Write to File option was clicked. 
Click Write to save the graph values.  

(b) Y-axis function as Velocity Magnitude was selected. 
Click Plot to plot the graph between Velocity Magnitude & Length of Channel. 
Write to File option was clicked. 
Click Write to save the graph values 

(c) Y-axis function as Pressure was selected. 
Click Plot to plot the graph between Pressure & Length of Channel. 
Write to File option was clicked. 
Click Write to save the graph values 

(d) Y-axis function as Wall Shear Stress was selected. 
Click Plot to plot the graph between Wall Shear Stress & Length of Channel. 
Write to File option was clicked. 
Click Write to save the graph values 

(e) Y-axis function as Skin Friction Coefficient was selected. 
Click Plot to plot the graph between Skin Friction Coefficient & Length of Channel. 
Write to File option was clicked. 
Click Write to save the graph values 

(f) Y-axis function as Surface Heat Transfer Coefficient was selected. 
Click Plot to plot the graph between Surface Heat Transfer Coefficient & Length of Channel. 
Write to File option was clicked. 
Click Write to save the graph values 

(g) Y-axis function as Surface Nusselt Number was selected. 
Click Plot to plot the graph between Surface Nusselt Number & Length of Channel. 
Write to File option was clicked. 
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Click Write to save the graph values 
 STEP 17 VIEW THE REPORT SUMMARY 

  REPORT>SUMMARY 
  Select all the report options. 
  Click Print to display. 
  Click Save to save the report summary. 
Repeat the above steps for other mesh files of the microchannels of different geometries. 
 

 
Figure 4: Contour of Temperature (Kelvin) 

 

 
Figure 5: Contour of Pressure (Pascal) 

 

 
Figure 6: Contour of Nusselt Number 
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Figure 7: Contour of Skin Friction coefficient 

 

 
Figure 8: Contour of Surface Heat Transfer Coefficient (W/m2K) 

 
6. Conclusions 
Two dimensional analysis of microchannel heat exchangers have been carried out using CFD package FLUENT 6.3 and the results 
obtained have been discussed. The following conclusions have made from the discussions: 
 
6.1. Fluid Temperature  
The maximum fluid temperature will be occurred at just above the channel bottom wall. It also observed that for given Reynolds 
number and hydraulic diameter the maximum fluid temperature obtained in the longer channel. It may be concluded that boiling may 
occur in the microchannel flow with low Reynolds number and high heat flux. The results show that for given heat flux and Reynolds 
number the maximum fluid temperature will occur in the larger hydraulic diameter. 
 
6.2. Nusselt Number 
The results show that Nusselt number decreasing along the direction of flow and it becomes almost constant, so we can conclude that 
as the flow becomes developed the Nusselt number becomes constant. It is well accepted with the conventional theory. For flows with 
given Reynolds number and heat flux the value of lower Nusselt number obtained in the smaller hydraulic diameter. 
 
6.3. Pressure Drop 
The pressure drop in smaller hydraulic diameter for the given length should be more compared to larger hydraulic diameter, but the 
pressure drop value of 50 μm (215 KPa) is smaller than the pressure drop value of 100 μm (526 KPa). This contradicts with the 
conventional theory. But the value of pressure drop value of 150 μm (223 KPa) is smaller than the pressure drop value of 100 μm (526 
KPa). For the given hydraulic diameter, the pressure drop will be more for larger channel length, this validates with the conventional 
theory. 
 
6.4. Skin Friction Coefficient  
The values of Skin friction coefficient decreasing along the direction of flow and becomes constant as the flow become developed. 
This validates well with conventional theory. 
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